
Keyboard shortcuts in the MediaLog
Alt+5 to switch to the MediaLog screen
Up and Down arrows to navigate the list of audio files.
Ctrl+L is Select.  It allows you to switch the folder that is displayed.  It will be used when you 

store commercials, jingles, liners or PSAs in separate folders from the music.
Ctrl+R is Refresh.  It refreshes the display of the current folder.  Anytime audio is added to the 

folder, you will need to refresh the screen to see all of the files.
Ctrl+N is New.  It allows the user to create a new audio file by opening the window to start a 

new recording.
Del is Delete.  It allows for deleting the highlighted audio file or files.  It will open a window 

asking if you are sure you want to delete.  Strike Y for Yes or N for No.
F2 is Search.  It allows the user to enter characters and filter to display only certain files.  It will 

look in the Description and Artist fields in addition to Filename.  Use Ctrl+R Refresh to go 
back to the display of all files.

F3 is Preview.  Striking F3 will play the highlighted file.  F3 will also stop the audio if is 
playing.

F4 is Info.  Info opens the AudioLog Editor window and allows the user to add or change 
information, such as the Description, Artist, or hit point.  Note: More shortcuts for 
maneuvering within the AudioLog Editor window below in a separate section of this 
document.

F5 is Print.  It will print a list of audio files in the folder.
F6 is Edit.  Edit will open the selected file into the default audio editor (GoldWave).
F8 is Split.  Split will split the screen and put a Notepad window on the bottom of the screen. 
F9 is Embed.  It will put a pointer to the selected audio file into the Notepad.  Used when putting 

actualities into a news story or when publishing to the web.
Ctrl+D is Dup.  It allows the user to duplicate or copy a file to another folder.
Ctrl+O is Lock.  It allows a user to lock a file (set it as read-only) to prevent deletions.  It will 

also toggle back to unlocked (remove the read-only attribute).
Alt+I is Import.  It is used to synchronize audio folders to copy files from Production to the 

Control/OnAir machine.
Ctrl+S is Send.  It allows a user to send the audio file to another station.  It requires additional 

software and will probably not be used.
Alt+F brings up the File menu. Then strike the hotkey M to rename the selected audio file.
Alt+E brings up the Edit menu.  Then strike the hotkey M to open the Mass Update Information 

window to make changes to a group of audio files.
Alt+T brings up the Setup menu.  Then strike the hotkey V to open the Preview Device window.  

It allows the user to change the audio device that will be used to preview audio from the 
MediaLog.



Keyboard shortcuts for the Audiolog Editor window
This is accessed from within the MediaLog.
Highlight the audio file to add information to.
Strike F4 on the keyboard.
Tab can be used to move between the fields in this window.
Alt+P will preview the audio.  It will also act as a toggle to stop audio while playing.
Alt+S will save changes and close the window.
Alt+C will activate the Cancel button and will close the window without saving changes.
Alt+N (formerly Alt+E) will play from the end of the file.
Alt+O will set the outro time / hit point while the audio is playing.
Alt+I will set the intro time while the audio is playing.
Alt+T will open the Trim window.  This allows a user to trim the audio by deleting the audio in 

the Intro and Outro times, only the audio file between the Intro and Outro times will be 
saved.

Alt+D will open the Day Parts window, where audio can be restricted to only playing at certain 
hours on certain days of the week.

Alt+R will reset the Start Date and Time fields to blank.
Alt+E will reset the Stop Date and Time fields to blank.



Keyboard shortcuts for the On Air screen
Alt+Shift+1 to switch to the OnAir screen.
Up and Down arrow keys to move to a different deck.
Ctrl+F7 to Eject All – This puts the cursor on Deck 10.
F7 to eject the audio from the current deck
Enter or Alt+F8 to load a new file into the current deck.
Ctrl+Shift+F8 to set all decks to Loaded status
Ctrl+F8 to set current deck to Loaded status
Ctrl+F3 to play the current deck
F3 to stack and play all loaded decks.
Number key to play audio in that number deck
F9 or space bar to Stack or cue audio in current deck
F1 Help
F2 Pause
F3 Play
F4 Stop
F7 Eject
Ctrl+F7 Eject All
Enter Load
Alt+L Import from playlist



Keyboard shortcuts for the Automate window
Alt+0 to switch to the Automate Deck Selector.  This will list the 8 decks, along with the playlist 

or program loaded in the deck and the current status of the deck.
While on the Automate screen, Ctrl+ the deck number will switch the display to that Automate 

deck. (example:  Ctrl+1 opens deck 1, Ctrl+8 opens deck 8.)
Up and Down arrow keys to move between sequence lines.
Ctrl+R is Refresh.  It refreshes the display of the sequence lines.  Used when audio is recorded 

and played back later.  The file may not exist when the playlist is loaded, so that wave file 
will show as “missing”.  After it is recorded, a refresh will show it ready to be played.

F1 is Wav.  It allows the user to put a Play Wave command on the selected sequence line.
F3 is Start.  It starts the playlist at the selected sequence line.
Shift+F3 is Start from End.  It allows the selected Play command to start the audio from the 

middle of the file.  It opens a window that allows the user to enter the time from the end of 
the audio to start playing.  It is useful when a long program has to be started partway thru to 
keep the program on time.

F4 is Stop.  It stops the playlist and leaves the cursor on the current sequence line.
F6 is Edit.  It allows the user to edit the selected command.
F8 is Load.  It loads a playlist into the deck.
F9 is Save.  It saves the current playlist.
Enter is Change.  Hitting the Enter key opens the list of commands to assign to that sequence 

line.
Del is Delete.  It removes the command on the selected sequence line.  Then it moves all 

following commands up one sequence line.
Ins is Insert.  It inserts a sequence line and moves all following commands down one sequence 

line.
Ctrl+E is Clear.  It clears the current playlist from the deck.  It will warn the user if changes were 

not saved.
Ctrl+C is Copy.  It allows the user to copy a series of commands and put them on the clipboard.
Ctrl+V is Paste.  It allows users to copy a series of commands from the clipboard or by entering 

the starting and ending sequence lines.
Ctrl+L is Lock.  It locks the cursor on the currently activated command.  This allows the playlist 

to always display the current line on the screen and track the playlist.  It also acts as a toggle 
to unlock the playlist.

Ctrl+S is Scroll.  It allows the user to move to a sequence line number by entering that value.
Ctrl+P is Step.  It allows the user to run one command on the current sequence line.  The playlist 

will not continue on after that command is activated.  It is useful for testing purposes.
Ctrl+B is Break.  It causes the currently playing audio to continue, but stop the playlist after it is 

done with the audio.  It is useful during Live times.
Shift+F4 Fd-Stop is Fade to Stop.  It will fade the currently playing audio over 5 seconds and 

stop the audio.  It is useful when breaking in with important news or alerts.
Ctrl+N is Notes.  It allows a user to enter notes about a playlist.  It is useful for manager to leave 

info for disc jockies.
Ctrl+A L-Ast is  Live Assist.  It will open the playlist into the Live Assist screen.
Alt+F brings up the File menu.  Then strike the hotkey T to import the Traffic log into the 

playlist.



Alt+F brings up the File menu.  Then strike the hotkey M to import the Music log into the 
playlist.

Alt+C brings up the Command menu to open the list of commands to assign to the current 
sequence line.  It has the same effect as hitting Enter on a sequence line, although the lists are 
set up slightly differently.

Alt+A brings up the Automate menu.  Then strike the hotkey V to insert a Voice Track onto a 
sequence line.  The Voice Track window has a separate list of keystrokes.

File Select window 
Up and Down arrow keys to navigate the list of files
Alt+L to Select Folder
Alt+I to open AudioLog Editor info window
Alt+F is Filter By.  You can limit what is displayed with this function.  Then key in your 
parameters and strike Enter.
Alt+P to Preview current audio file (will both start and stop audio)
Alt+C to Cancel
Enter or Alt+O for Ok button



Keyboard shortcuts for the FileLog screen
The FileLog is where the rotations will be managed.
Alt+2 to switch to the FileLog screen
Up and Down arrows to navigate the list of text files and rotations.
Enter to open the selected text file.
Ctrl+L is Select.  It allows you to switch the folder that is displayed.  It will be used when you 

store commercials, jingles, liners or PSAs in separate folders from the music.
Ctrl+R is Refresh.  It refreshes the display of the current folder.  Anytime a file is added to the 

folder, you will need to refresh the screen to see all of the files.
Del is Delete.  It allows for deleting the highlighted file or files.  It will open a window asking if 

you are sure you want to delete.  Strike Y for Yes or N for No.
F2 is Search.  It allows the user to enter characters and filter to display only certain files.  It will 

look in all of the fields.  Use Ctrl+R Refresh to go back to the display of all files.
F3 is All.  Striking F3 will display all the files in the folder.  This can be used after doing a 

search to get back to displaying all files.
Ctrl+I is Info.  Info opens the Text File Header window and allows the user to add or change 

information.  Is used more with news stories. 
F5 is Print.  It will print the text of the highlighted file.
Alt+M is Move  This will move the selected file to another custom folder.
Alt+P is Rip & Read  This will copy the text of the highlighted file and paste it into the Notepad 

or other open files.
Alt+U is Rundown  This is used in newsrooms when reading stories on air.
Ctrl+E is Email  This will allow a story (including embedded audio) to be sent via email to a set 

list of addresses.
F6 is Archive  This will allow a copy of the file to be put into a different custom folder.
F7 is Notepad   This will switch the screen to the last opened notepad.
F8 is Split   This will split the screen with the Notepad.
F11 is Prior  This will open the story above the highlighted story.  Used by newsrooms when 

reading stories on air.
F12 is Next  This will open the text of the next story in the list. Used by newsrooms when 

reading stories on air.



Keyboard Shortcuts for the Notepad window
The Notepad will be used to create and edit the rotations
Alt+1 will switch to the Notepad screen
Ctrl+N is New  This clears the text from the Notepad and opens a blank notepad.
F4 is Save  This will save the current text as a file to the selected custom folder.
F5 is Print  This will print the text in the current notepad. If any text is highlighted, it will only 

print that highlighted text.
Ctrl+W is Wave  Allows the user to choose an audio file to “embed” at the cursor position in the 

notepad.
F3 is Play  This will play the next embedded audio file below the cursor position.
Shift+F3 is Stop  This will stop the audio that is currently playing.
F6 is Archive   This will save the current text as a file to the selected custom folder.  Slightly 

different from F4, as F6 will allow multiple files with the same slug.
F10 is Open  Allows the user to open a saved text file into the Notepad.
Ctrl+F is Find   Opens a window that will search the notepad for the entered text.
Ctrl+I is Info.  Info opens the Text File Header window and allows the user to add or change 

information.
Ctrl+T Time   Displays the number of words in the text file, and calculates the time it will take to 

read the text and play the embedded audio files.
Ctrl+M is Email   This will allow a story (including embedded audio) to be sent via email to a set 

list of addresses.  Requires Outlook.
Alt+S is Send     Allows the user to send text and audio to other locations.  Used with 

WANReady.
Alt+B Web  Allows the user to publish text and audio to a web site.  Requires additional 

software from WireReady.
Alt+P Rip & Read   Copies and pastes the selected text to an opened text file.
Alt+K is Spell Check Entire Document   Will check the spelling of text in the entire document.


